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Welcome 
to making an  
accessible  
document

Accessible Document

Digital Accessibility
The Americans with Disabilities Act (ADA) Title II 

requires state and local governments to make 

their electronic information and technology 

accessible to people with disabilities. 

This means more than 25 million people rely on 

documents being accessible. Individuals involved 

in the design, development, distribution, and use 

of documents are responsible for ensuring that 

those documents comply with  ADA Title II. 
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Section 01 
Users with Disabilities

Users with 
Disabilities

Types of Disabilities 

Digital documents can often create barriers for 

people with disabilities. Many of these barriers 

are easy to remove with education around how 

people with disabilities use technology. People 

with disabilities are impacted by inaccessible  

digital documents in different ways.  

Disabilities can vary person-to-person but, 

with digital documents, we look into four 

categories: Visual, auditory, motor, and 

cognitive and learning disabilities are the 

main categories.
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Section 01 
Users with Disabilities

People with auditory disabilities
•	 Auditory disabilities can be a mild or moderate hearing loss in one or both 

ears, known as hard-of-hearing.

•	 Auditory disabilities can also be substantial and uncorrectable hearing loss in 

both ears, known as Deaf.

•	 Occasionally, a person with an auditory disability can hear sounds but  

sometimes not sufficiently enough to understand all speech,  

especially in the presence of excessive background noise. This includes those 

who use hearing aids.

•	 Provide captions and transcripts to all audio or multimedia content to ensure 

accessibility to users who are Deaf or hard-of-hearing.

People with visual disabilities
1.	 Visual disabilities can include users that are blind, have low vision, and/or have 

color-blindness.

2.	 In most cases, users who are blind use a screen reader to access  

electronic documents. A screen reader uses the structure of a document to 

present the text to the user. Images use alternative text to convey their  

meaning to the user.

3.	 Users with low vision may enlarge document content so that it is more legible 

to them.
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People with cognitive and 
learning disabilities
•	 Users with cognitive and learning disabilities are one of the largest  

disability groups.

•	 Cognitive, learning, and neurological disabilities involve neurodiversity and 

neurological disorders, as well as behavioral and mental health disorders.

•	 These can impact how well people hear, move, see, speak, and  

understand information.

Section 01 
Users with Disabilities

People with motor disabilities
•	 Motor disabilities are also known as physical disabilities.

•	 These can include weakness and/or limitations of muscular control such as  

involuntary movements including tremors, lack of coordination, or paralysis 

and limitations of sensations,  joint disorders, pain that impedes movements, 

and missing limbs.

•	 Some users with physical disabilities can have difficulty using a mouse.  

Therefore, a document should be structured to be navigable with  

just a keyboard.

•	 Some users will use a mouth stick, eye-tracking device, or a sip and puff device 

in place of a traditional keyboard.
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Section 01 
Users with Disabilities

Assistive Technology
•	 Many users' accessibility needs are met with the use of assistive  

technology, which includes screen readers, screen magnification, and  

high-contrast settings.

•	 Assistive technology products include a wide variety of both software  

and hardware.

•	 Assistive technology works through a standard keyboard interface and  

accessibility frameworks which report information about the content and 

structure of a document to screen readers and other assistive technologies.

•	 Because users with cognitive and learning disabilities can vary widely,  

designing content and structure to be easy to use and understandable will help 

address accessibility.

Examples:
Some of the most common forms of assistive technology include:

•	 On-screen keyboards: these enable people to use a pointer in place of a  

keyboard to type text.

•	 Voice-recognition software: converts spoken word into typed text.

•	 Screen readers: converts text into spoken word or other forms of  

communication such as Braille.
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Section 01 
Users with Disabilities

•	 The Narrator screen reader: part of Windows that has a touch mode that can 

perform screen reading tasks by processing touch gestures.

•	 Screen adjustment programs: these can adjust the display or areas of it such 

as high contrast themes, dots per inch screen settings, and a  

magnifier tool.

Screen Readers
•	 Screen readers provide access to text within a document by rendering it into 

spoken language or a Braille output.

•	 The most important information that a screen reader needs in order to help 

users understand or navigate a document is proper document structure.

•	 In addition to a screen reader vocalizing what is appearing on the screen, a 

screen reader offers a wide range of keyboard shortcuts to navigate through 

the document with a greater ease.

•	 Screen readers can be used both on a mobile device as well as a desktop.

Braille Displays
•	 Users who are blind or have low vision can use Braille displays.

•	 Braille displays complement the standard keyboard and screen reader.

•	 The content of the document is transcribed into Braille.
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Section 01 
Users with Disabilities

Ensuring Proper Document Structure
•	 There are several types of structural elements built into a document that aid in 

navigation and organization of a digital document.

•	 Having structure ensures all users understand the content of the document.

•	 Assistive technology uses the structure of a document to allow the user to  

navigate using specific commands to jump to or skip through headings, lists, 

and bookmarks content.

•	 An assistive technology user relies on the keyboard to activate objects and 

navigate within a document. Therefore, it is important the document has both 

accessibility and meaningful text.

•	 Linked text should clearly describe the content to be found or action to be  

performed.

•	 People who use screen readers sometime scan a list of links.

•	 To preserve tab order and to make it easier for screen readers to read  

documents, use a logical heading order and built-in formatting tools.

Accessible Text
•	 Some users have sight limitations that make it difficult for them to read text 

unless it has adequate contrast against the background.

•	 Some users have difficulty reading text that is simply too small.



PAGE  12  ACCESSIBLE DOCUMENT GUIDE

Web Content 
Accessibility  
Guidelines (WCAG)

Section 02 
Web Content Accessibility Guidelines

WCAG 2.1

The Web Content Accessibility Guidelines (WCAG) 

are a set of guidelines that help explain how to 

make web content and electronic documents  

accessible to people with disabilities. 

The overall goal of WCAG is to provide a single 

shared standard for web content accessibility that 

meets the needs of individuals, organizations, and 

governments. WCAG has 12 guidelines grouped 

under 4 principles: perceivable, operable,  

understandable, and robust. Together, these  

create a solid framework for accessibility.
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Perceivable 
•	 Perceivable makes it so all users can receive and recognize content  

regardless of their disability.

•	 Provide text alternatives for any non-text content so that it can be changed 

into other forms people may need. This can be large print, Braille, speech,  

symbols or simpler language.

•	 Provide alternatives for time-based media.

•	 Create content that can be presented in different ways without losing  

information or structure.

•	 Make it easier for users to see and hear content including separating  

foreground from background.

Section 02 
Web Content Accessibility Guidelines

Operable
•	 Operable makes it so all users can navigate and interact with document  

content and functionality.

•	 Make all functionality available from a keyboard.

•	 Provide users enough time to read and use content.

•	 Do not design content in a way that is known to cause seizures.

•	 Provide ways to help users navigate, find content, and determine where  

they are in the document.

•	 User interface components and navigation should be operable.
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Robust
•	 Robust makes it so all users can utilize content and functionality  

using an assistive technology device.

•	 Maximize compatibility with current and future assistive technologies.

Section 02 
Web Content Accessibility Guidelines

Guidelines and Success Criteria
•	 To maximize accessibility for people with disabilities, WCAG contains  

12 guidelines.

•	 Guidelines include: text alternatives, time-based media, adaptable,  

distinguishable, keyboard accessible, enough time, seizures and physical  

reactions, navigable, input modalities, readable, predictable, input  

assistance, and compatible.

•	 Success Criteria are used as a tool for testing to measure conformance with 

the guidelines.

Understandable
•	 Understandable makes it so all users can interpret and process  

the content.

•	 It should be readable, legible, comprehensible, and consistent.

•	 Make document pages appear and operate in predictable ways.

•	 Help users avoid and correct mistakes.
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Section 02 
Web Content Accessibility Guidelines

Types of Documents
A document is considered accessible if it meets certain technical criteria and can 

be used by people with disabilities. This guide will focus on Word documents and 

exporting as PDF.

•	 To improve performance for interactive viewing, PDF defines a more  

structured format than that used by most PostScript language programs.

•	 PDF also includes objects, such as annotations and hypertext links, that are not 

part of the page itself but that are useful for interactive viewing and document 

interchange.

•	 A logical tagged structure tree is used within each document to provide a 

meaningful reading order for content, as well as a method for defining  

structural elements role and relationship to page content. Within this tag  

structure, other properties such as alternative text and replacement text can 

be provided.

•	 There are three levels of conformance defined for Success Criteria: Level A, 

Level AA, and Level AAA.

•	 Level A is the minimum level for accessibility. If the document does not reach a 

Level A Success Criteria rating, a user with disabilities is most  

likely being excluded from the document.

•	 To reach Level AA, your document must meet all the Level A  

requirements first.

•	 Level A/AA is typically used by the Department of Justice as a standard for  

document accessibility.
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Characteristics 
of a PDF

Section 03 
Characteristics of a PDF

Main Characteristics of 
a PDF Document 

Optimally, document accessibility should begin 

with the native document format. 

For this guide, that means a document created in 

Microsoft Word and then exported as a PDF. Once 

the document is exported as a PDF, they should 

contain a few similar characteristics.
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Section 03 
Characteristics of a PDF

Searchable Text
Scanning a document creates images of text rather than searchable text. Assistive 

technology cannot read or extract the words in a graphical representation of text. 

If a PDF contains scanned text, it must be converted into searchable text using  

optical character recognition (OCR) before addressing accessibility in  

the document.

Accessible Fonts
All font characters in the document should be able to be extracted to text. Adobe 

Acrobat extracts characters in a document to Unicode text when you read a PDF 

with a screen reader, or when saved for a Braille embosser. The extraction will fail 

if the font cannot be mapped to the Unicode characters. It is important to utilize 

simple fonts for this reason.  

Labeled Form Fields
When the document contains an interactive form a user must be able to enter 

values into the form field. Interactive PDF forms should have a defined tab order 

which will allow assistive technology to use the Tab key as a way to navigate to 

each form field. Overall, forms within a document should provide identification, 

give tips on proper completion, and prevent errors within the form. 
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Section 03 
Characteristics of a PDF

Document Structure Tags
A screen reader requires a document to be structured in order to present the text 

to the user in a way that makes sense. Document structure tags in a PDF define 

the reading order and help identify headings, paragraphs, sections, tables, and 

other page elements. A document structure also helps when documents are re-

sized for viewing at larger sizes and on mobile devices.

Alternative Text
Providing good, equivalent alternative text is important for users who are blind 

or have low vision. Images in a document cannot be understood by the user of a 

screen reader unless there is alternative text associated with the image. Tooltips 

can also help many users, including those with learning disabilities. There should 

also be equivalents for multimedia, including any audio or video elements.

Navigational Aids
Navigational aids within a document can be links, bookmarks, headings, a table of 

contents, a preset tab order for form fields. Each of these helps users skip around 

the document without having to read the entire document. This is especially  

helpful for screen reader users. 



PAGE  19  ACCESSIBLE DOCUMENT GUIDE

Section 03 
Characteristics of a PDF

Other Accessible PDF Characteristics
•	 Document language and Title Labeled

•	 No information that relies on color to convey meaning

•	 Contrast ratios that meet the WCAG 2.1 guidelines: 4.5:1 for normal text,  

3:1 for text larger than 18 point, and 3:1 for graphics

•	 Audio controls

•	 Using text for layout rather than images of text

•	 No flashing objects

•	 No focus change without input from the user

•	 A consistent navigation throughout and identification of elements

Simple and Clear Writing
Everyone can benefit from clear and understandable text. For people with  

cognitive or learning disabilities, clear and understandable text becomes a  

critical component of accessibility. Plain language should be used to ensure the 

user understands the information as quickly, easily, and completely as possible.  

A user can understand this kind of communication the first time they read or  

hear it.
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Section 04 
Document Structure

Document  
Structure

Creating an 
Accessible Document  
in Microsoft Word 

Within the Word navigation pane, users can see  

all the headings of a document, their relative  

positions and the current location by clicking parts 

of the pane. Internal links and bookmarks are also 

important for proper page structure because they 

help users navigate within the document. 

Word has many features built-in that help  

people with different abilities read and author 

documents.
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Headings
•	 Headings in a document are used to organize content. 

•	 Heading structure is often the most important component of an  

accessible document.

•	 Headings are especially helpful to users who use assistive technology to  

understand how the information is structured and quickly navigate to  

specific topics.

Section 04 
Document Structure

Heading Styles
•	 Headings should be structured in a hierarchical way, with the level 1 headings 

for the title of the document, level 2 headings for the major sub-sections, and 

so on.

•	 When structuring your heading, it is important to use the Microsoft Word  

styles to ensure the document is accessible for assistive technology users.

Applying a Heading Style
1.	 Locate and highlight the text for the heading.

2.	 Navigate to the Home tab and locate the Styles pane. 

3.	 Select the appropriate heading level or navigate to the more down arrow to 

browse other default styles.
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Section 04 
Document Structure

Modify heading style

1.	 Navigate to style on Home tab.

2.	 Right-click on style and select Modify.

3.	 Edit the style in the Modify Style dialog box.

Heading structure

•	 In most instances, there should only be one Heading 1 per document.

•	 A Heading 2 identifies and describes a major section of the document.

•	 A Heading 3 identifies a subsection of the Heading 2 section.

•	 Headings define the document structure. Therefore, you should not skip  

heading levels. For example, there should always be a Heading 3 between a 

Heading 2 and Heading 4. 
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Section 04 
Document Structure

Images
•	 Images can be used to convey trends and statistics, illustrate important  

concepts, capture moments in time, and add interest to documents.

•	 Screen readers rely on alternative text (alt text) on images to provide meaning.

•	 When applied properly, alt text is both spoken by screen readers and  

displayed as a tooltip for others who wish to read it.

Font
•	 Font size should be at a minimum 14 point for large print. 18 point  

is recommended.

•	 Font size should be at a minimum 11 point for normal print. 16 point  

is recommended.

Non-Serif Font
Serif Font

18 Point Large Print
11 Point Normal Print

•	 A non-serif font is recommended because when the text is magnified, the  

serifs in the fonts do not smooth well and the text can look blocky.

•	 Non-serif fonts are Arial and Calibri. Serif fonts include Times New Roman  

and Century.
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Section 04 
Document Structure

Applying alternative text

•	 Limit the number of characters for alt text to less than 120.

•	 Use concise and meaningful alt text that describes the image sufficiently.

•	 The description should provide enough information so the purpose of the  

image in a document can be understood even when removed.

•	 It is not recommended to use the Generate a description for me option for 

adding alt text.

Adding alternative Text to image

1.	 Right-click on image in document.

2.	 Select Edit Alt Text.

3.	 Add alt text to box.

4.	 Check Mark as decorative if image does not convey any meaning.
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Section 04 
Document Structure

Complex Image

•	 Images that contain graphs, charts, and diagrams require a more  

detailed description to convey important or useful information.

•	 For descriptions that are longer than 120 characters, the description should  

be placed in surrounding text, footnote, or an appendix.

•	 The alt text can contain a title to the graph, chart, or diagram and the  

paragraph text below can describe the data in detail below. 
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Color and Contrast
•	 Color can enhance content within the document, making it easier to  

understand and read for some people with learning disabilities.

•	 The main focus for color in a document is having enough contrast  

between the foreground and background, for text and images.

•	 Color should not be used in any way to convey meaning.

•	 Any important information denoted through color needs to be available 

through text as well.

Contrast standards

•	 For text less than 18 point or 14 point bolded, there should be a contrast of 

4.5:1 or more.

•	 For text larger than 18 point or 14 point bolded there should be a contrast of 

3:1 or more.

•	 It is best to avoid busy images as a background for text.

Section 04 
Document Structure
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Columns
•	 Columns are most commonly used to break up large bodies of text that cannot 

fit in a single block of text on a page, such as a newspaper or magazine article, 

long lists of items, or flyers.

•	 Do not use Tab or Spacebar to create columns.

•	 Columns must be created correctly for a screen reading software to read the 

text correctly and not linear.

Making columns in a document

1.	 Select the text where columns need to be applied.

2.	 Select Layout from the toolbar.

3.	 Find the Page Setup section and select Columns.

4.	 Select the desired number of columns from the available choices. 

•	Or select More Columns at the bottom of the drop-down menu.

5.	 Customize the column options and click OK.

Section 04 
Document Structure
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Lists
•	 Lists are used in a document to help identify order and hierarchy. Lists must be 

properly formated to allow users with screen readers the ability to identify and 

navigate through a related group of items.

•	 The built-in options in Microsoft Word programmatically identify the  

type of structure to screen reader users.

•	 Plain text bullets and numbers are more accessible than pictograph  

bullets and numbers.

•	 It is important to select the type of bullet provided in the list styling  

options because these characters are a type of text that can be translated by  

a screen reader or other assistive technology.

Making columns in a document

Section 04 
Document Structure
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Links
•	 Links can be displayed three ways in a document; raw URL's, descriptive text, 

or as an image.

•	 When using a linked object or image, it is important to have meaningful alt text 

about where the link leads.

•	 Links provide a navigation structure in a document.

Creating a list

1.	 Select the text where lists need to be applied.

2.	 Locate the Paragraph section on the Home tab.

3.	 Select the Bullets, Numbering, or Multi-level list option.

4.	 Select the type of bullets, numbers multi-level list from the  

drop-down menu.

Meaningful link text

•	 It is very important to provide meaningful link text.

•	 The text should describe the content behind the link or the action that will  

occur by activating the link.

•	 Do not use "click here" or "read more" for links.

•	 Avoid repeated text for links throughout the document. 

Section 04 
Document Structure
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Creating a link

1.	 Navigate to the Insert tab and click the Link button.

2.	 Select Insert Link.

3.	 Confirm the Insert Hyperlink dialog box appears.

4.	 Select the appropriate button under the Link to: options.

5.	 Insert descriptive text under the Text to display field

6.	 Insert the Address or location where the link should lead and click OK.

Section 04 
Document Structure



PAGE  31  ACCESSIBLE DOCUMENT GUIDE

Tables
•	 Tables within a document are used to organize and display associated data  

in a structural manner.

•	 A table can be visualized as a grid. There are horizontal and vertical lines that 

intersect to create individual cells.

•	 When the data in the table is read left to right, the user is reading the contents 

of a row.

•	 When the data in the table is read top to bottom, the user is reading  

column information.

•	 The two types of tables are layout tables and data tables.

Section 04 
Document Structure

Creating a table

1.	 Navigate to the Insert tab and click the Tables button.

2.	 Select Insert Table from the menu options.

3.	 The Insert Table dialog appears.
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Section 04 
Document Structure

4.	 Enter the number of desired columns and rows in the appropriate fields.

5.	 Click OK and confirm an empty table appears in the document.

Structure of a table

•	 Data tables should be formatted using the Word data table structure tools.

•	 A header cell is the title of the row or column.

•	 A data cell is the meaningful content related to the header cell.

•	 Both the header and data point within a table needs to be placed in its own 

table cell.

•	 Data tables need to re-identify column headers after each page break.

•	 Screen readers display lengthy tables as independent table structures on each 

page.

Create a table header

1.	 Place the insertion point in a table cell within the desired header row.

2.	 Select the Table Design tab at the top of the screen.

3.	 Locate the Table Styles Options pane.

4.	 Select the Table Layout tab at the top of the screen.

5.	 Ensure the Header Row checkbox is checked.
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Section 04 
Document Structure

6.	 Under the Data section ensure the Repeat Header Rows option  

is selected.

Table characteristics

•	 When creating a more complex table, it is recommended to create an  

accessible alternative in addition to the document. For example, a  

properly marked-up HTML or PDF table.

•	 Empty cells can be misinterpreted or improperly conveyed by some  

assistive technologies. 

•	 Visual formatting needs to be applied with table border control rather than 

blank rows or columns.

•	 Table summaries can be helpful in describing the purpose of a table.

Forms
•	 Forms within a document are used to collect information.

•	 Examples include medical information, file purchase requests, and  

complete surveys.

•	 A basic form layout usually includes a label or question and a space  

for user input.

•	 Currently, it is not possible to make a form fully accessible in Microsoft Word. 
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Section 04 
Document Structure

Table of Contents
•	 A table of contents (TOC) is an important tool to aid in document  

navigation and display the layout of content.

•	 TOCs use the same basic structure as lists.

•	 TOCs are especially important for larger documents so assistive  

technology can quickly navigate the document.

•	 Microsoft Word searches for heading styles and creates a TOC based on that 

structure.

•	 Each time content is nested under the main heading, it is indented  

visually beneath its related item. 

Therefore, HTML and PDF formats are recommended for creating  

electronic forms.

•	 All fillable form fields should be contained in protected sections  

of the document. 

•	 Instructional content for the form should be placed in unprotected  

sections of a document so that an assistive technology user can access  

the information.

•	 Each field needs a meaningful description so that it can be  

properly recognized.
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Section 04 
Document Structure

Creating a table of contents

1.	 Navigate to the References tab and locate the Table of Contents pane.

2.	 Select the Table of Contents drop-down menu.

3.	 Select one of the Automatic or Manual table options from the menu.

4.	 Confirm a Table of Contents structure appears in the document.

Modifying table of contents

•	 Word has an option to show page numbers or to make each item in the TOC 

into a hyperlink.

•	 The styles for the TOC can be customized for headings and levels.

•	 Any changes that are made to title and section information is important to  

update, as they do not automatically update.
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Bookmarks
•	 Bookmarks are a valuable tool for navigating lengthy documents.

•	 Bookmarks are used to indicate important sections or locations that a user  

can refer to at a later time.

•	 The order that bookmarks are listed should reflect the order of each  

relevant section within the document.

Section 04 
Document Structure

Add a bookmark

1.	 Place the cursor where the bookmark needs to be added.

2.	 Navigate to the Insert tab and locate the Links pane.

3.	 Select the Bookmark button.

4.	 Enter a bookmark name with no spaces and select the radio button to  

reference by name or location and click Add.

5.	 Use F5 to see a list of the Bookmarks in document.
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Document Language
•	 Screen readers pronounce words according to the language specified.

•	 If the text is another language, a screen reader will mispronounce the words  

in the document.

•	 The language set for all or just a part of a document needs to match the  

language that is visually displayed.

Section 04 
Document Structure

Adding language to a document

1.	 Navigate to the Review tab and locate the Language pane.

2.	 Select the Language drop-down menu.

3.	 In the Language dialog box choose English (U.S.) or another appropriate lan-

guage for the content.

4.	 Click OK.
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Testing for 
Accessibility

Section 05 
Testing for Accessibility

Accessibility Checker 

Microsoft Word has a built in Accessibility 

Checker tool that helps to identify  

accessibility issues and provides a  

few solutions for fixing them. 

The checker also categorizes severity levels. 

The three levels are error, warning, and tip. 

Although the checker is a valuable tool, it 

cannot guarantee that a document will be 

100% accessible to people with disabilities.
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Section 05 
Testing for Accessibility

Accessibility Checker
•	 The three severity levels are error, warning, and tip.

•	 An error means that not fixing the element will make the document  

extremely difficult or impossible to a user using assistive technology.

•	 A warning means that a document can be challenging for a user using  

assistive technology.

•	 A tip is an issue that could improve that user's overall experience.

•	 The checker will look into organizing content using paragraph headings,  

alternative descriptions for images, identify table headers, meaningful link  

text, and grouping related list items.

Viewing the results

1.	 Navigate to the Review tab and locate the Accessibility pane.

2.	 Select the Check Accessibility button.

3.	 Verify the Accessibility Checker pane opens on the right side of  

the document.

4.	 Highlight an item in the results pane to jump to where it is located  

in the document.



This document was adopted from material developed by the Rocky Mountain ADA Center.
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